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Introduction

What is ChadEdit?

ChadEdit is the visual editor for USR-5 configurations. A USR-5 configuration fully defines a USR-5 user
interface including all devices, macro groups, panel layouts, button appearances, and button, direct-access and
left/right key behaviors (including all IR codes). ChadEdit always has a single configuration opemrehe
configuration SeeWhat is a CCF? for more information on USR-5 configuration files.

ChadEdit provides two complementary views on the current configuration. On the left side of

ChadEdits main window yolll find the configuration viewa typical tree view of the overall structure of the

current configuration. At the top level of this tree viewY¥idind HOME, DEVICES andMACRO GROUPS.

These top levels are associated with the home section, the right hand side device menu and the left hand side
macro group menu on your USR-5.

configuration view

panel view

UnderneatEVICES is a list of devices, and underneMACRO GROUPS is a list of macro groups.
UnderneattHOME, every device and every macro group is a property item and a list of panels. The property
item underneatllOME provides access to the USR-5 system properties, and the property item underneath a
device or macro group provides access to the properties of that device or macro group.

Included in these properties are the definitions of the direct-access and left/right keys.

On the right side of ChadEditmain window yolll find panel viewsA panel view displays the contents of a
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Loading and Saving
You need to choose the type of USR-5 first.

Before beginning to program, you should tell ChadEdit whether you are programming a USR-5
or a USR-5RF. After you have set this property once and cleared the “Show this dialog at startup”
check box, you can forget about it, ChadEdit will remember your choice in any future programming
session. The Title Bar shows your current settings. If you want to change your settings, click RF
User Interface from the Settings menu.

How do | upload a configuration from my USR-5?
1. Start ChadEdit.

2. Connect one end of the USR-5 serial cable to your USR-5 and connect
the other end to a serial port of your PC.

3. Click on & in the toolbar, or select Upload from RC Device from the
File menu.

4. ChadEdit now tries to connect to your USR-5. If ChadEdit cannot connect
to your USR-5, it will display a message saying USR-5 not connected or
not responding. You can click on the Details >> button to open a window
listing all the serial ports on your PC.

 If another application is using the serial port to which your USR-5 is
connected you can either try another serial port or have the other
application release the serial port.

+ If ChadEdit could open the serial port to which your USR-5 is connected
but still could not connect, check to see if both ends of the cable are
properly inserted and if USR-5’s batteries have not run out. Then wait a
few seconds and try again. If after a number of tries ChadEdit still cannot
connect, try resetting your USR-5, wait until it beeps twice and try again.

5. After connecting to your USR-5, ChadEdit will upload the configuration
from your USR-5 and load it into ChadEdit. If ChadEdit’s current
configuration is not empty, ChadEdit will ask you if you want to Merge
with current configuration or replace it?. If you decide to merge,
ChadEdit will add all home panels, devices and macro groups uploaded
from your USR-5 to the current configuration. If you decide to replace,
ChadEdit will remove the current configuration (if it has been modified,
you will first be allowed to save it) and replace it with the configuration
uploaded from your USR-5.

You can cancel the upload at any time by clicking on the Cancel button.

It is best to not touch your USR-5’s screen or use any of your USR-5’s direct
access buttons, while uploading is in progress.
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How do | download a configuration into my USR-5?

1.
2.

Start ChadEdit.

Connect one end of the USR-5 serial cable to your USR-5 and connect
the other end to a serial port of your PC.

. Make sure you have a configuration in ChadEdit either by uploading one

from your USR-5 (see How do | upload a configuration from my USR-
57?) or by loading one from a file (see How do | load a configuration
from a CCF into ChadEdit?).

. Click on & in the toolbar, or select Download into USR-5 from the File

menu.

. ChadEdit generates the configuration. If the resulting configuration does

not fit in your USR-5’s available memory, ChadEdit will tell you it is too
large and cancel the download. Based on how oversized the configuration
is (ChadEdit displays this information both in absolute and relative terms)
you should delete some elements and try again.

ChadEdit now tries to connect to your USR-5. If ChadEdit cannot connect
to your USR-5, it will display a message saying USR-5 not connected or
not responding. You can click on the Details >> button to open a window
listing all the serial ports on your PC.

 If another application is using the serial port to which your USR-5 is
connected you can either try another serial port or have the other
application release the serial port.

+ If ChadEdit could open the serial port to which your USR-5 is connected
but still could not connect, check to see if both ends of the cable are
properly inserted and if USR-5’s batteries have not run out. Then wait a
few seconds and try again. If after a number of tries ChadEdit still cannot
connect, try resetting your USR-5, wait until it beeps twice and try again.

. After connecting to your USR-5, ChadEdit will check the configuration in

your USR-5.

+ If your USR-5 does not contain a valid configuration, ChadEdit will display
a message saying Failed to get valid information from USR-5, do
you want to overwrite any configuration currently in USR-5?. Click
No or Cancel if you don’t want to overwrite the configuration in your
USR-5. Click Yes to continue downloading.

+ If your USR-5 contains a modified configuration, ChadEdit will display
a message with the creation date and time of this configuration, and
ask you if you want to overwrite it. Click No or Cancel if you don’t want
to overwrite the configuration in your USR-5. Click Yes to continue
downloading.

12
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8. ChadEdit will now download the configuration into your USR-5. After

downloading, your USR-5 will tell you when it is ready to be used again by
beeping twice.

You can cancel the download at any time by clicking on the Cancel button, but doing so may result in a
corrupted configuration in your USR-5 (you can fix this by fully downloading a configuration).

access buttons, while downloading is in progress.

I It is best to not touch your USR-5’s screen or use any of your USR-5’s direct

How do | load a configuration from a CCF into ChadEdit?

There are a number of ways to load a CCF into ChadEdit.
When ChadEdit is running.

1.

Load a CCF into ChadEdit by doing one of the following
» drag a CCF and drop it on ChadEdit, or

« click on [E¥ in the toolbar or select Open Configuration... from the
File menu and select a CCF

. ChadEdit now loads the selected CCF. If ChadEdit has a non-empty

current configuration, ChadEdit will ask you if you want to Merge with
current configuration or replace it?. If you decide to merge, ChadEdit
will add all home panels, devices and macro groups from the loaded
CCF to the current configuration. If you decide to replace, ChadEdit will
remove the current configuration (if it has been modified, you will first
be allowed to save it) and replace it with the configuration from the
loaded CCF.

When ChadEdit is not running.

1.

Start ChadEdit and load a CCF by doing one of the following
+ double click on a CCF, or

» drag a CCF and drop it on the ChadEdit icon

13
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How do | save the configuration in ChadEdit in a CCF?

If the current configuration in ChadEdit is not empty, you can save it in a CCF by clicking on H in the toolbar,
or selecting Save Configuration or Save Configuration As... from the File menu.

If a saved configuration would not fit in your USR-5, ChadEdit will tell you it is too large and cancel the save.
Based on how oversized the configuration is (ChadEdit displays this information both in absolute and relative
terms) you should delete some elements and try again.

14
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Basic Tasks

In this section we assume ChadEdit is running and contains the configuration
you want to change.

How do | start with the factory default CCF?

The ChadEdit distribution comes with a single sample CCF in
<install>/Samples where <install> is the directory where ChadEdit has been
installed. This sample CCF is called default_udb.ccf and it contains the factory
default configuration loaded in your USR-5. Load this CCF to start with the factory
default CCF. See How do | load a configuration from a CCF into ChadEdit?
for instructions on how to load a CCF into ChadEdit.

How do | open a panel view?

1. Find the name of the panel you want to open in the tree view on the left
side of the ChadEdit window. Click on [# in front of DEVICES or MACRO
GROUPS to display the list of all devices or macro groups. Click on # in
front of HOME, or a device or macro group name, to display the list of all
its panels.

2. Double-click on the name of the panel you want to open. A panel view for
that panel will open in the area on the right side of the ChadEdit window.

Closing a panel view will not undo any changes made to that panel view. A panel
view is merely a view on the current configuration, and any changes to it are
immediately incorporated into the current configuration.

15
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How do | add a button to a panel?

1. Open the panel view of the panel to which you want to add a button.

2. If the button and frame gallery is not visible, open it by clicking on ﬁ in
the toolbar or selecting Gallery from the Tools menu.

3. Select a group of frames and buttons by clicking on the group’s name in
the list on the left side of the gallery window. Alternatively, you can use the
cursor UP and DOWN keys to change the selection.

4. Click on the button you want to add, drag it to the panel view and drop it
where you want to add it. If the button you want to add is embedded in a
frame, clicking on that button will select the entire frame. Hold down a
SHIFT key while clicking on a button in the gallery to select only that button.

How do | remove a button from a panel?

1. Open the panel view of the panel with the button you want to remove.

2. Select the button you want to remove by clicking on it. A red frame will
appear around the selected button.

3. Press the DELETE key.

How do | move a button in a panel?

1. Open the panel view of the panel with the button you want to move.

2. Select the button you want to move by clicking on it. A red frame will appear
around the selected button.

3. Hold down the left mouse button and move the cursor to drag the button to
a new location. The status bar shows the current location of the selected
button. Alternatively you can use the cursor keys to move the button. To
move it faster with the cursor keys, hold the SPACE bar at the same time.

How do | copy a button?

1. Open the panel view of the panel with the button you want to copy.

2. If you want to copy a button to another panel, then open the panel view of
the panel to which you want to copy a button.

3. Hold down a CTRL key, click on the button you want to copy, hold down
the left mouse button and drag the button to the location to which you want
to copy it, and release the left mouse button to drop the dragged button.

16
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I ChadEdit does not support copying from one running copy of ChadEdit to another.

How do | rename a button?

1. Open the panel view of the panel with the button you want to rename.

2. Select the button you want to rename by clicking on it. A red frame will
appear around the selected button.

3. Press F2 and a name dialog with an on-screen keyboard will open. Click
on the Shift button to change from one keyboard layout to another (the
keyboard layouts are equal to the ones on your USR-5). Click on a key
button to add the symbol depicted on that button. You can also use your
PC keyboard to enter regular alphanumeric characters.

4. Press the ENTER key when you’re done.

How do | change the font used in a button?

1. Open the panel view of the panel with the button of which you want to
change the font.

2. Double-click on the button of which you want to change the font, or select
the button by clicking on it and press the INSERT key.

3. The Button Properties sheet appears. Select the Properties tab, and
choose a font from the drop-down list.

4. Click on the Apply button to look at the result of the change in the panel
view, and click on the OK button to accept the change or on the Cancel
button to decline it.

How do | copy all bitmaps from one button to another?

After creating a button and putting a few actions into its action list, you may want to change the appearance of
that button without having to recreate the action list. You can easily do this by copying all bitmaps from another
button to this button.

1. Open the panel view of the panel with the button to which you want to
copy bitmaps.

2. If you want to copy bitmaps from a button in another panel, open the panel
view of that panel. If you want to copy bitmaps from a button in the gallery,
open the gallery (see How do | add a button to a panel? for instructions
on how to open the gallery).

3. Press and hold an ALT key, click on the button from which you want to
copy icons, drag it to the button to which you want to copy bitmaps, and
drop the dragged button.

17
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How do | assign an IR code to a button?

1.

Open the panel view of the panel with the button to which you want to
assign an IR code.

Double-click on the button you want to assign an IR code to, or select the
button by clicking on it and press the INSERT key.

The button property sheet appears. Select the Action tab.

If the list of actions is not empty, select an action by clicking on it and
press the DELETE key until the list is empty (merely to ensure that this
button will only have a single IR code assigned to it).

Click on the Set IR button. The Add IR sheet appears.

There are two ways to assign an IR code.

to assign a code from the IR database:

a.

f.

Select the device for which you want to set the IR code from the
Devices drop-down list.

. Select the brand of the device from the Brands drop-down list.

. For some brands the IR codes are divided into different code sets.

Select, if necessary, the appropriate set from the Code Set drop-
down list.

. Select which function has to be performed from the Functions list.

Click on the Test IR button to try out the selected function on your
USR-5. Before you perform this step, make sure to connect one end
of the USR-5 serial cable to your USR-5 and connect the other end to
a serial port of your PC. If the code set you selected doesn’t work
properly, return to the step ¢ above and select a different code set.

Click on the OK button.

to assign a code by learning it:

a.

Connect one end of the USR-5 serial cable to your USR-5 and
connect the other end to a serial port of your PC.

. Click on the Learn IR button.

. Press the button you want ChadEdit to learn on the remote you

want to learn from like you would do when learning on your USR-5
ChadEdit will return with one of three replies:

Learning completed successfully. The learned code has been
put in the list of actions. Press the OK button to close the button
property sheet and assign the code to the selected button.

Learning failed (timeout). ChadEdit successfully connected to your
USR-5, but somehow couldn’t learn the code. Try again and if it still
doesn’t work, refer to your USR-5 user guide to trouble shoot IR
code learning.

18
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* USR-5 not connected or not responding. You can click on the
Details >> button to open a window listing all the serial ports on
your PC.

+ If another application is using the serial port to which your USR-
5 is connected you can either try another serial port or have the
other application release the serial port.

+ If ChadEdit could open the serial port to which your USR-5 is
connected but still could not connect, check to see if both ends of
the cable are properly inserted and if USR-5’s batteries have not
run out. Then wait a few seconds and try again. If after a number
of tries ChadEdit still cannot connect, try resetting your USR-5,
wait until it beeps twice and try again.

See How do I create a macro? for information on how to assign more than a single IR code to a button.

How do | assign an IR code to a direct-access or left/right key?

The USR-5 has two kinds of key definitions: global and per-device. Whenever there is no per-device definition
(or an empty per-device definition), the global definition is used. There is only one global definition per key, but
there is a per-device definition per key for every device and macro group.

+ to assign an IR code to the global definition of a key:

1. Double-click on System Properties underneath HOME in the
configuration tree view.

2. The USR-5 System Properties sheet appears. Select the Hard Keys
tab, click on the key as shown left, which you want to assign an IR
code, and proceed with step 4 of How do | assign an IR code to a
button?.

» to assign an IR code to the per-device definition of a key:

1. Double-click on the Properties item underneath the device or macro group
in the configuration tree view for which you want to assign an IR code.

2. The Device Properties or Macro Group Properties sheet appears. Select
the Hard Keys tab, click on the key as shown left, which you want to
assign an IR code, and proceed with step 4 of How do | assign an IR
code to a button?.

How do | assign a source switch IR code?

1. Double-click on the Properties item underneath the device or macro group
in the configuration tree view for which you want to assign a source switch
IR code.

2. The Device Properties or Macro Group Properties sheet appears. Select
the Action tab and proceed with step 4 of How do | assign an IR code to

a button?.
19
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How do | change the RF Settings?

The USR-5RF can be set to transmit radio frequency (RF) signals, which allows you to operate your devices
inside closets or in an adjacent room. To receive these RF signals and convert them to infrared signals, you will
need an RF Receiver (RFR-5 : optional).

In the RF settings you can set Extender IDs and Channels. Both have to be identical to the ID- and CH-dials on
the RF Receiver(s). Refer to the RF Receiver User Manual for more details.

Note:

The RF settings can also be set on the USR-5RF. Refer to the USR-5RF User
Manual for more details. The RF transmission feature is not available on the
USR-5.

Defining an Extender ID
1. Open the Device Properties or Macro Group Properties.
2. Select the RF tab.

3. Select an Extender ID.
Make sure that this ID matches with the ID on the RF Receiver.

4. Click OK to accept the properties.
-or-
Click Cancel to return without changing the properties.
Defining the RF Channel
1. Open the USR-5 System Properties.

2. Select the RF tab.

3. Select an RF Channel.
Make sure the RF Channel matches with the CH on the RF Receiver.

4. Click OK to accept the properties.
_or_

Click Cancel to return without changing the properties.
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How do | let a button jump to a panel?

Any button (or key) can jump to any panel (or be a link to that panel). This is a very powerful feature which
allows you to create your own USR-5 user interface structure.

1.

3.
4.

Open the panel view of the panel with the button to which you want to
assign a ‘jump action’.

Double-click on the button to which you want to assign a ‘jump action’ or
select a button by clicking on it and press the INSERT key.

The button property sheet appears. Select the Action tab.

Select the panel to jump to in the Jump drop-down list.

There are a couple of special ‘panels’ in the Jump drop-down list:

MOUSE MODE switches your USR-5 into a mouse mode in which your
USR-5’s touch screen acts as a touch pad to operate compatible*
interactive devices.

SCROLL UP scrolls up to the previous panel, exactly like the scroll button
at the top of your USR-5’s screen would do.

SCROLL DOWN scrolls down to the next panel, exactly like the scroll
button at the bottom of your USR-5’s screen would do.

How do | move a panel?

1.

Select the panel you want to move in the tree view on the left side of the
ChadEdit window.

Hold down the left mouse button and drag the panel to its new location. If
you drop a panel on another panel, it will be inserted before the panel you
drop it on. If you drop a panel on HOME, a device or a macro group, it will
be appended to the list of panels of HOME, that device or that macro
group.

Alternatively, move the selected panel up or down its current list by holding
down a CTRL button while using the cursor UP or DOWN key.

How do | copy a panel?

1.

Select the panel you want to copy in the configuration tree view.

* Compatible with Philips DVX8000, October 2001
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2. Press CTRL + C or select Copy from the Edit menu to copy the selected
panel into ChadEdit’s clipboard.

3. Select HOME, or the device or macro group you want to copy the panel to
and press CTRL + V or select Paste from the Edit menu.

l ChadEdit does not support copying from one running copy of ChadEdit to another.

How do | add a panel?

Select a panel, HOME, or the device or macro group to which you want to add a panel and click on @ in the
toolbar or select Add Panel from the Panel menu. If a panel is selected, the newly added panel is inserted just
before the selected panel.

A newly added panel has the default contents of a home, device or macro group
panel. To add an empty panel, hold down a SHIFT key while adding the panel.

How do | move a device or macro group?

1. Select the device or macro group you want to move in the tree view on the
left side of the ChadEdit window.

2. Hold down the left mouse button and drag the device or macro group to its
new location. If you drop a device or macro group on another device or
macro group, it will be inserted before the device or macro group you drop it
on. If you drop a device or macro group on DEVICES or MACRO GROUPS,
it will be appended to the last of the list for devices or macro groups.

Alternatively, move the selected device or macro group up or down its
current list by holding down a CTRL button while using the cursor UP or
DOWN key.

Devices and macro groups are essentially equal. It is merely its location,
underneath DEVICES or underneath MACRO GROUPS, which makes a device
and a macro group. You can move a device from DEVICES to MACRO GROUPS
to turn that device into a macro group, and vice versa.

How do | copy a device or macro group?

1. Select the device or macro group you want to copy in the configuration
tree view.

2. Press CTRL + C or select Copy from the Edit menu to copy the selected
device or macro group into ChadEdit’s clipboard.
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3. Select DEVICES or MACRO GROUPS and press CTRL + V or select Paste
from the Edit menu.

4. If you copy a template device (a device with ()’s around its name), the copy
will also be a template device. Select Is Template in the Device menu to
change a template device into a regular device.

I ChadEdit does not support copying from one running copy of ChadEdit to another.

How do | add a device or macro group?

Click on ﬁ in the toolbar or select Add Device from the Device menu to add a device. Click on I.+-' i

toolbar or select Add Macro Group from the Macro Group menu to add a macro group.

A newly added device or macro group is completely empty.

How do | update the software in my USR-5?

The software in your USR-5 can easily be updated to a later version. USR-5 software is distributed in single
files, called USR-5 Update Files. When you double click on a USR-5 Update File, it will launch ChadEdit
which will take you through the updating process. After completing an update, ChadEdit will ask you if you
want to make the USR-5 Update File, the standard USR-5 Update File. The standard USR-5 Update File is
used if you select Update USR-5... from the Tools menu in ChadEdit.

ChadEdit is distributed with a standard USR-5 Update File with the latest available
USR-5 software. We strongly advise you to update your USR-5 using this USR-
5 Update File.

Before you start the updating process, you should connect one end of the USR-5 serial cable to your USR-5 and
connect the other end to a serial port of your PC. During the update process, you should read the messages that
appear on your PC screen and push the appropriate buttons.

It is possible that after updating your USR-5, it asks you to calibrate the touch screen. Please refer to your USR-
5 User Guide for detailed instructions on calibration.

It is best to not touch your USR-5’s screen or use any of your USR-5’s direct
access buttons, while updating is in progress.
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Timers

On your USR-5 there is the possibility to execute a certain action at a predefined
time and day. This functionality is called a timer.

In ChadEdit it is possible to add a timer to every button, device or macro that is defined. On your USR-5
however timers can only be edited in macro buttons. This means that you can add a “hidden” timer to a device
button, which cannot be edited by the user.

A timer can have a STAR T and a ST OP action, each with their own time and day of execution.

How do | create — add a Timer Group?

» Select a Macro Device, press the left mouse key, select the option “Is
TimerGroup”

» Or: Select a Macro Device, on the Menu bar select “Macro Group”, select
“Is TimerGroup”

The Macro Group will now be displayed between the brackets ‘<’ *>’

How do | create — add a Timer Action?

A Timer Action — like any other USR-5 action — can be added in an actionlist of a button, a key or a device,
using the properties box.

Only an ““alias” action can be assigned as the STAR T/ST OP action of a timer. Pressing the “action key” will
open the “Alias” dialog box, from which an “alias” can be selected.

Unlike “USR-57, ChadEdit only uses a 24-hour clock. The default time displayed in the START & STOP time
is 00:00. Initially, no days are selected.

How do | repeat a timer action weekly?

In the timer edit dialog mark the checkbox labeled “Wkly”. In this case, when a timer action was triggered, it
will be rescheduled at the same day and hour.

You can do this separately for the start and stop actions.
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Advanced Tasks

In this section we assume ChadEdit is running and contains the configuration you want to change. We also
assume that you know how to open specific panel views.

How do | resize a button or a frame?

Buttons and frames can only be resized if they do not have any bitmaps. If a button has one or more bitmaps, the
width of the button is fixed to the smallest width of all its bitmaps and the height of the button is fixed to the
smallest height of all its bitmaps. The same is true for frames except that a frame can have at most one bitmap.

If a button or frame has no bitmaps, you can resize it as follows:

1. Select the button or frame you want to resize by clicking on it. A red frame

will appear around the selected button or frame.

. Release the left mouse button and move over the edge of the button or

frame until the cursor changes into a resize cursor with the desired
orientation.

. Hold down the left mouse button and move the cursor to drag the edge

underneath it and resize the button or frame. The status bar shows the
current size of the selected button or frame.

Alternatively you can use the cursor keys to resize the button or frame.
Hold down a SHIFT key to move the top or left edge, and hold down a
CTRL key to move the bottom or right edge. To move an edge faster with
the cursor keys, hold the SPACE bar at the same time.

Il You can only resize a button or frame if it has no bitmaps.

How do | use my own bitmaps?

Every button or frame can have its own unique bitmaps. A buttons can have up to four bitmaps, one for each of
its states. A frame can have only one bitmap.

Bitmaps take up memory and having many different bitmaps means there is
less room for other data, like IR codes. You can help minimize the memory bitmaps
require by reusing bitmaps, where possible, on your buttons and frames. ChadEdit
checks for equal bitmaps when saving a configuration by looking at the actual
bitmap contents, and only saves unique bitmaps

The four states of a button are.

inactive and unselected
inactive and selected
active and unselected

active and selected
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Abutton is active when it has a non-empty action list. It is inactive when it has no
action list or its action list is empty. A button is selected when you push on it on
the USR-5. It is unselected when it is waiting to be pushed.

To set a bitmap of a button, take the following steps:

1. Double-click on the button you want to set a bitmap for, or select the button
by clicking on it and press the INSERT key.

2. The Button Properties sheet appears. Select the Icons tab.

3. Double-click on the bitmap you want to load, and select a Windows bitmap
file. ChadEdit can load any Windows bitmap file that has 1, 4 or 8 bits per
pixel and is at most 240 by 219 pixels (the size of a panel). ChadEdit will
automatically convert a color bitmap into a grayscale version more suitable
for display on your USR-5.

4. Click on the OK button to accept the new bitmap or on the Cancel button
to decline it.

To set the bitmap of a frame, take the following steps:

1. Double-click on the frame you want to set the bitmap for, or select the
frame by clicking on it and press the INSERT key.

2. The Frame Properties sheet appears. Select the Icons tab.

3. Double-click on the bitmap, and select a Windows bitmap file.
ChadEdit can load any Windows bitmap file that has 1, 4 or 8 bits per
pixel and is at most 240 by 219 pixels (the size of a panel).
ChadEdit will automatically convert a color bitmap into grayscale version
more suitable for display on your USR-5.

4. Click on the OK button to accept the new bitmap or on the Cancel button
to decline it.

If a button has one or more bitmaps, the width of the button is fixed to the smallest
width of all its bitmaps and the height of the button is fixed to the smallest height
of all its bitmaps. The same is true for frames except that a frame can have at
most one bitmap.

How do | create a macro?

On your USR-5 there is a clear distinction between macros and ‘regular buttons’. In ChadEdit such a distinction
does not exist. Every button and every direct-access or left/right key can either perform a single action, like
transmit an IR code, or be a macro and perform a whole list of actions.
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All macros can be used on your USR-5, but only macro buttons in a macro
group panel can be edited on your USR-5.

To create a macro, take the following steps:

1. Double-click on a button or select a button by clicking on it and press the
INSERT key.

2. The Button Properties sheet appears. Select the Action tab.

3. The currently assigned list of actions is displayed on the right side of the
property page. The currently assigned jump panel is displayed underneath
the list of actions. Click on one of the buttons on the left side of the property
page to add an action to the list:

Alias: click on this button to open a tree view of all devices, direct-
access and left/right keys, and buttons in the current CCF. Select an
item to add an alias to that item to the action list. When your USR-5 is
executing an action list and comes across an alias, the action list referred
to by that alias is executed. Aliases are shown in the action list preceded
by [A] for a device alias, [K] for a direct-access or left/right key alias,
and [B] for a button alias.

Delay: click on this button to add a delay to the action list. Hold a SHIFT
key while clicking on this button to set the default delay duration. You
can always double click on a delay in the action list to change its duration.
Delays are shown in the action list preceded by a [D].

SET IR: click on this button. The Add IR sheet appears. IR codes are
shown in the action list preceded by a [C]. Proceed with step 6 of How
do | assign an IR code to a button?.

Delete : click on this button to delete an action from the action list.

Beep : click on this button to add a beep to the action list. You must
enter Frequency, Duty Cycle and Duration. You can always double click
on a Beep in the action list to change these parameters. Beeps are
shown in the action list preceded by a [S].

Timer : click on this button to add a timer action. See How do | create
— add aTimer Action?.
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4. Repeat step 3 to add up to 255 actions to the action list.

5. If you want your USR-5 to ‘jump to’ a specific panel when it is done executing
the action list, select the panel to jump to in the Jump drop-down list.

I When executing an action list, your USR-5 ignores panel jumps in aliases.

Actions can be moved up or down the action list, by selecting the action to be moved, holding down a CTRL
key and using the cursor UP or DOWN keys. Alternatively, you can drag actions up or down the action list
using the mouse.

How can | use panel view grids?

Panel view grids are a helpful tool to line up buttons and frames. A panel view grid is a set of up to 64 horizontal
and 64 vertical line segments. The main use for grids is grid snapping, which restricts button and frame locations
to grid locations, the locations where the line segments of a grid intersect. Grid snapping affects button and
frame moving, dropping a button or frame dragged from a panel or the gallery, as well as button or frame
resizing.

All grid functions are accessible through the Grid submenu of the Panel menu or the Grid submenu of the
panel view pop-up menu. Default grid settings, which affect all newly opened panel views, can be set in the
Settings menu. The following is an overview of some of the things you can do with grids:

» ChadEdit stores 10 different default grids, which are automatically assigned
to a panel view when it is opened. The grids can be modified per panel
view without affecting the default grids. Use the Set Default Grid submenu
of the Settings menu to set any of ChadEdit’s default grids to the current
grid of the active panel view.

+ To change the current grid of a panel view, enable grid editing by selecting
Edit Grid in the Grid submenu. The Edit Grid item is only enabled if a grid
is currently visible.

» A horizontal grid line can be added by holding down a CTRL key while
clicking on a horizontal grid line. A similar approach works for vertical
grid lines.

» The selected grid line can be deleted by pressing the DEL key. Note
that every grid must contain at least one horizontal and one vertical
grid line. Therefore, the last horizontal and vertical grid line cannot be
deleted.

»  When you put the selected grid line on top of another grid line and you
deselect the selected grid line, the selected grid line is deleted.

» To add a vertical grid line to the right of two other vertical grid lines at
the same distance as the distance between the two other vertical grid
lines, hold down a CTRL key and press the cursor RIGHT key. A similar
approach works for a vertical line to the left of two vertical grid lines and
horizontal grid lines.

» To create an evenly spaced grid, use the Auto Grid... menu item.
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By default ChadEdit snaps the top left corner of a button or frame to the
nearest grid location. However, you can instruct ChadEdit to snap to any
corner or the center of a button or frame using the Snap Mode submenu
of the Grid submenu. Note that the snap mode does not affect resizing,
only placement or moving.

To make the current grid of panel A the current grid of panel B: make the
current grid of panel A default grid 9 (or any other unused grid, we just
picked 9 for this example), close panel B, open panel B, and select grid 9.

To move an entire grid, hold down a SHIFT key and use the mouse or the
cursor UP or DOWN key to move the grid.

Use the Export Grids or Import Grids items in the Files menu to export
or import the default grids to or from a text file. This allows you to keep
your grids with your CCFs and makes it easier to make changes to your
CCFs afterwards.

W Grids are not stored in CCFs.

How can | better select in a panel view?

Here are some tips that can help you select the right button or frame when a panel contains many elements:

If a button or frame is selected and the move or resize cursor is visible
when you press the left mouse button, the selection does not change.
Therefore, clicking on a button in a selected frame does not select that
button. If you want to select the topmost button or frame at the cursor location,
press the ESC key before pressing down the left mouse button. Pressing
the ESC key will always deselect the current selection.

Press the TAB key to select the next sibling of the selected button or frame.
Hold down a SHIFT key while pressing the TAB key to select the previous
sibling of the selected button or frame.

Use the zoom feature to get a better view of what you are selecting.

How can | make ChadEmulator faster?

If you find ChadEmulator a little slow you can make it faster by changing the shape of ChadEmulator’s window
into a rectangle. To do this, right click on ChadEmulator’s window to activate its pop-up menu, and select

Transparent.

29



ChadEdit User Guide

How can | make a screenshot in ChadEmulator?

Simply press the PRINT SCREEN button to save the currently displayed screen of ChadEmulator in a Windows
bitmap file. ChadEmulator will tell you the full path of the file it saves (the screen shots usually go into directory
C:\OnkyoScreens). ChadEmulator saves up to 100 screenshots before it starts using the same filenames again.

How can | create my own gallery?

ChadEdit loads the gallery from <install>/Usr-5/gallery.ccf, where <install> is the directory where ChadEdit
has been installed. Simply load gallery.ccf as a regular CCF (which it is), make modifications like you would
do for any other configuration, and save the modified configuration back in gallery.ccf. The next time ChadEdit
is started, it will use the modified gallery.

Note that ChadEdit ignores all but the GALLERY panels of gallery.ccf (HOME has been renamed into
GALLERY in gallery.ccf).

How can | create my own default panels?

ChadEdit loads default panels from <install>/Usr-5/home.ccf,
<install>/Usr-5/device.ccf, and <install>/Usr-5/macro.ccf, where <install> is the
directory where ChadEdit has been installed. Simply load any of these CCFs,
modify the configuration, and save it back. The next time ChadEdit is started, it
will use the modified default panels.

The default macro panel CCF serves a second purpose: when you create a new
macro group on your USR-5, the panels of that macro group are actually copies
of the default macro panel.

Note that ChadEdit ignores all but the first DEFAULT panel of a default panel
CCF (HOME has been renamed into DEFAULT in the default panel CCFs).

How can | write-protect a configuration?

A write-protected configuration cannot be altered on your USR-5. This is useful if you want to set up a configuration
with ChadEdit and don’t want anyone to inadvertently make changes to it when they use your USR-5.

After loading a write-protected configuration in your USR-5, you can only access
USE mode on your USR-5. Write-protecting a configuration does not affect any
ChadEdit operations.

A configuration can be write-protected by taking the following steps:

1. Double-click on System Properties underneath HOME in the configuration
tree view.

2. The USR-5 system property sheet appears. Select the USR-5 System
Properties tab.

3. Check the configuration is write-protected box to make this configuration

write-protected.
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How can | copy a device from one CCF to another?

Running copies of ChadEdit do not share a clipboard. This means that you cannot
copy a device from one CCF to another by running two copies of ChadEdit and
simply copying the device. Here is a workaround:

1. Load the CCF from which you want to copy a device.
2. Delete all but the device you want to copy.

3. Load the CCF to which you want to copy the device, and merge it with the
current configuration.

4. Save the configuration in the proper CCF.
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